Using the Configuration Menu (continued)

Status > Log > Log Settings

Pgﬂ%&gﬁlﬁ ?Alr} Plj lus iy

High-Speed 2.4GHz Wireless Router
Home Advanced Tools : Status m

DI-624 l

Loy settings

Logs can be saved by sending it to an admin email address.
—
Device Info

SMTP Setvet / 1P Address |

Email Address | Send Mail Mo

Log Type ¥ System Activity

Log
S ™ Debug Infarmation
* Stats .
¥ Attacks

" Dropped Packets

—_—
' Wireless

¥ Matice

9 90

Apply Cancel Help

Not only does the Broadband Router display the logs of activities and events, it can setup
to send these logs to another location.

SMTP Server/
IP Address - The address of the SMTP server that will be used to send the logs

Email Address - The email address to which the logs will be sent.
Click on Send Mail Now to send the email.
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Using the Configuration Menu (continued)
Status > Stats

D Link AIRRluS =
High-Speed 2.4GHz Wireless Router

Home Advanced Tools Status m

DI-624 \

Traffic Statistics

Traffic Statistics display Receive and Transmit packets passing through the DIFE24.

T )
Device Info Refresh | Reset | o

Help
Receive Transmit
VAN 3964 Packets 277 Packets
LAN 1317 Packets 2321 Packets
WIRELESS 11g 553 Packets 0 Packets

—
' Wireless

The screen above displays theTraffic Statistics. Here you can view the amount of pack-
ets that pass through the DI-624 on both the WAN and the LAN ports. The traffic counter
will reset if the device is rebooted.

Status > Wireless

D-Link

Building Networks for People

“AmrPlus i
IENE
High-Speed 2.4GHz Wireless Router

_ Home Advanced ( Tools Status I!E_
s Connected Wireless Client List o |

2 LIS
The Wireless Client table below displays Wireless clients Connected to the AP o
¥ o int).
I bevice Info (Access Point) Help
Connected Time MAC Address Mode

!
Log

© Stats

Wireless

DI-624 l

The wireless client table displays a list of current connected wireless clients. This
table also displays the connection time and MAC address of the connected wireless
client.

Click on Help at any time, for more information. 38



Networking Basics

Using the Network Setup Wizard in Windows XP

In this section you will learn how to establish a network at home or work, using
Microsoft Windows XP.

Note: Please refer to websites such as http://www.homenethelp.com
and http://www.microsoft.com/windows2000 for information about networking

computers using Windows 2000, ME or 98.

Go to Start>Control Panel>Network Connections
Select Set up a home or small office network

Nebtwork Setup Wizard

Welcome to the Network Setup
Wizard

Thiz wizard will help you zet up this computer (o un on your
network. With a network, pou can:

Share an Internet connection

Set up Internet Connection Firewall
Share files and folders

Share a printer

LI I

To continue, click Mest.

[ Cancel

When this screen appears, Click Next.
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Networking Basics

Please follow all the instructions in this window:

Network Setup Wizand

Before you continue.__

Before you continue, review the thecklist for creating a netwark.

Then, complete the following steps:

+ Inztall the network cards, moderns, and cables.

+ Tun on all computers, printerz, and external modems.
+ Connect ta the Intermet.

“When pou click Mest, the wizard will search for a shared Intemet connection on your network.

Click Next

In the following window, select the best description of your computer. If your computer
connects to the internet through a gateway/router, select the second option as shown.

Network Setup Wizard

Select a connection method.

Select the statement that best describes this computer:

() Thiz computer connects directly to the Intemnet. The other computers on my network connect
to the Internet through this computer,

Wiew an example.

@gThis computer connects to the [ntemet trough another computer on my network. or through i
‘atesidential gateway,
Wiew &t example.
N

() Other

Learn miore about hame or small affice netwaork. confiqurations.

r—

< Back l Mewt > ' Cancel

Click Next
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Enter a Computer description and a Computer name (optional.)

Network Setup Wizard
Give this computer a description and name.

[Qomputer deszcriphion: Mary's Computer

—

Examples: Family Room Computer or Monica's Computer

[ Computer narme: Office ]
Evamnples. FAMILY of MONICE

The curent computer name iz Office

Learn maore about computer names and descriptions.

< Back l Mext = ' Cancel

Click Next

Enter a Workgroup name. All computers on your network should have the same
Workgroup name.

Network Setup Wizand

Hame your network.

Mame your netwark. by specifving a workgraup hame belaw. All computers on pour netwark,
should hawve the same work group name.

“Workgroup name: Accounting

Examples HOME or OFFICE

< Back Mext » Cancel

Click Next



Networking Basics

Please wait while the Network Setup Wizard applies the changes.

Network Setup Wizard

Ready to apply network sethings. .

The wizard will apply the following settings. This pracess may take a few minutes to complate
and cannot be interupted.

Settings:
Metwork settings: A
Computer description: Mary's Computer
Computer name: Office
‘wiorkgroup name: Accounting
The Shared Documents folder and any printers connected to this computer have been
shared.
v

To apply these settings, click Mest.

’ < Back ﬂ Mest » i[ Cancel
\

When the changes are complete, click Next.

Please wait while the Network Setup Wizard configures the computer.
This may take a few minutes.

Hetwork Setup Wizard

Pleaze wait._.

Pleaze wait while the wizard configures thiz computer for home or small office networking, This
process may take a few minutes.
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In the window below, select the option that fits your needs. In this example, Create a
Network Setup Disk has been selected. You will run this disk on each of the

computers on your network. Click Next.

Network Setup Wizand

You're almost done...

* - You need to run the Metwork Setup wizard once on each of the computers an your
\E) network. To run the wizard on computers that are not running *Windows P, you can use
the Windows *P CD or a Metwork Setup Digk.

“w'hat do you want to da?

() Use the Netwark Setup Disk | already have
() Use my Windaws X CD

(2 Just finish the wizard; | don't need ta run the wizard on other computers

e

Insert a disk into the Floppy Disk Drive, in this case drive A.

Network Setup Wizand

Inzernt the dizk you want to use.

Inzert a disk the inta the follawing disk drive, and then click Mest.
3% Floppy [&:)

If you want to format the disk, click Format Disk.

Click Next.
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%]

Copying...

L -/

Please wait while the wizard copies files, ..

[ ) Zancel |

Please read the information under Here’s how in the screen below. After you complete
the Network Setup Wizard you will use the Network Setup Disk to run the Network

Setup Wizard once on each of the computers on your network. To continue click Next.

Metwork Setup Wizand

To run the wizard with the Network Setup Disk_.. %

® . Complete the wizard and restart this computer. Then, uze the Metwork Setup Dizk torun
\J) the Metwaork Setup Wizard ance on each of the other camputers an paur netwark.

Here's how:
1. Inzert the Metwork Setup Dizk into the nest computer you want to nebwark,

2. Open My Computer and then open the Metwork Setup Digk.
3 Double-clhick "netzetup "
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Please read the information on this screen, then click Finish to complete the
Network Setup Wizard.

Hetwork Setup Wizand

Completing the Network Setup
Wizard

You have successfully set up this computer for home or zmall
office networking.

For help with home or zmall office nebworking, zee the
fallowing topics in Help and Support Canter:

+ Uszing the Shared Documents folder
+ Sharing filez and folders

To zee other computers an your nebwaork, click Start, and then
click ky Metwark Places.

To cloze thiz wizard, click Finizh.

| <Back Firish |

The new settings will take effect when you restart the computer. Click Yes to restart
the computer.

System Settings Change |g|

P You must reskark your computer before the new setkings will take effect.
-

oy

Do wou want ko restark your computer now?

o oves | [ Mo

You have completed configuring this computer. Next, you will need to run the Network
Setup Disk on all the other computers on your network. After running the Network

Setup Disk on all your computers, your new wireless network will be ready to use.
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Naming your Computer

To name your computer, please follow these directions:In Windows XP:

B Click Start (in the lower left corner of the screen)

B Right-click on My Computer

B Select Properties and click

_\ Internet
Internet Explorer
w5 E-mail

A Outlook Express

(XN _Crmand Prompk

v M3M Explorer

® ‘Windows Media Player
@ Windows Movie Maker
@ Tour \Windows ¥P

? Files and Settings Transfer
- “Wizard

_-_] My Documents
;} My Recent Documents »

_f} My Pictures
]

¢ My Music
!I My Computer |
| Open

‘} My Network  Explore
| Search...
Bﬂ Control Panel  Manage
Map Metwork Drive. ..

e Connect Ta
=1

L::é Printers and F

Disconnect Metwark Drive, ..

Show on Desktop
Rename

B Selectthe Computer
Name Tab in the System
Properties window.

B You may enter a
Computer Description if
you wish; this field is
optional.

m Torename the computer
and join a domain, Click
Change.

System Properties

Remote
Advanced

tic Updates

Syztem Fest
| Computer Hame ||

General | Hardware

9

Computer description:

Windows uzes the following information to identify your computer
ot the netwark,

For example; "Kitchen Computer or "Mary's
Carmputer'.

Full computer name:  Office

Whark group: Accounting

To uzge the Metwork, Identification Wizard to join &
domain and create a local user account, click Metwark,

Torename this computer or join a domain, click Change.
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Naming your Computer

M |n this window, enter the
Computer name

B Select Workgroup and enter
the name of the Workgroup

B All computers on your network
must have the same

Computer, Hame Changes

Yaou can change the name and the membership of thiz
computer. Changes may affect access to network resources.

Computer name:

Office

Full computer name:

Office
Workgroup name.
B Click OK tember of
() Domair
(=) whorkgroup:
Accounting

o]

Checking the IP Address in Windows XP

The wireless adapter-equipped computers in your network must be in the same IP Ad-
dress range (see Getting Started in this manual for a definition of IP Address Range.) To
check on the IP Address of the adapter, please do the following:

B Right-click on the Disable
Connectionicon -
Repair

in the task bar
Wiew Awailable Wireless Metworks

Open Network Connections

B Click on Status
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Checking the IP Address in Windows XP

This window will appear.

[ | Click the
Support tab
[ | Click Close

Wireless Hetwork Connection 7 Status

General || Support

2Ix)

Internet Pratocal [TCPAR)

Addreszs Type: Azzighed by DHCP

| 1P addess 1921880114 |
Subret Mazk: 255.255.255.0
Default Gateway: 192.168.0.1

Detailz...

Cloze

Assigning a Static IP Address in Windows XP/2000

Note: Residential Gateways/Broadband Routers will automatically assign IP Addresses
to the computers on the network, using DHCP (Dynamic Host Configuration Protocol)
technology. If you are using a DHCP-capable Gateway/Router you will not need to assign

Static IP Addresses.

If you are not using a DHCP capable Gateway/Router, or you need to assign a Static IP
Address, please follow these instructions:

B GotoStart

Double-click on
Control Panel

g@ Tour Windows 5P |
1& Paink

y | Files and Settings Transfer
- Wiizard

All Programs D

E-’ Control Panel

h;é Printers and Faxes

g) Help and Suppart

Search

ERun...

CFf |6| Turn OFF Carnputer
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Assigning a Static IP Address in Windows XP/2000

B Control Panel

File Edit ‘View Favarites Tools Help
O Back L) ﬁ p Search [E" Faolders -v
Address [} Control Panel
= P5 Accessibility Options
ﬂ’ Control Panel &) ::: Haerware b
. (i of Remove Programs
. DOUb|e-C|ICk on [3, Switch ko Cakegory Yisw A Administrative Tools
Network Date and Time
Connections See also
‘ U S U D 7 Game Controllers
@) Help and Support Pnkernet Options
Phone and Modem Options
o Power Options
aPrinters and Faxes
e Regional and Language Options
= Scanners and Cameras
" Network Connections
File Edt View Favorites Tools  Advanced  Help
Qo - ©Q - [F| O search [ Fokders
Address | Network Connsctions
A Mame
Network Tasks LAN or High-Speed Internet
[ create anew
connection Disable
1 1 ) Set hi ll
B Right-click on Local Area e puotus
i @ Dissbls this network —_—
Connections device Bridge Connecticns
Q Repair this connection Croate shortet
B[} Rename this connection Delete
& view status of this Rename

connection

Change settings of this
connection

B Double-click on
Properties Other Places

@ Control Panel b
\'_} My Netwark Places

(L) My Documents

i My Computer

Details
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Assigning a Static IP Address
in Windows XP/2000

B Click on Internet Protocol
(TCP/IP)

B Click Properties

B Input your IP address and
subnet mask. (The IP
Addresses on your network
must be within the same
range. For example, if one
computer has an IP Address
0f 192.168.0.2, the other
computers should have IP
Addresses that are
sequential, like 192.168.0.3
and 192.168.0.4. The subnet
mask must be the same for
all the computers on the
network.)

B Inputyour DNS server
addresses. (Note: Ifyou
are entering a DNS
server, you must enter the
IP Address of the Default
Gateway.)

The DNS server information will be supplied

by your ISP (Internet Service Provider.)

B Click OK

-L Local Area Connection 7 Properties

2]

General | Advanced

Connect using:

B  D-Link DWL-AB50

This connection uzes the following items:

Igl, Clignt for Microzoft Metworks

S File and Printer Sharing for Microzoft Networks
B 305 Packet Scheduler
Internet Protocol [TCPAP) I

Inztall...

[ escription

Tranzmizzion Contral Protocal/|ntermet Protocol. The default
wide area network, protocol that provides communication
aciogs diverse inkerconnected networks.

i

[ Show icon in notifization area when connected

Ok ] [ Cancel

Internet Protocol (TCP/IP) Properties @rz|

General

You can get IP settings assigned automatically if your network, supports
this capability. Otherwize, you need to ask your netwark. administrator for
the appropriate [P settings.

(C) Obtain an IF address automatically

‘@ Uze the fallowing IP address: '
1P address: 192 .168. 0 . 2
Subnet mazk: 2892862860 0

Default gateway:

(@ Usg the following DNS server addresses.)

Preferred DMS server:

Alernate DMS server

o
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Assigning a Static IP Address with Macintosh OSX

CX5) System Preferences. o
ICRL-B. % N
B Go to the Apple Menu and se- m Om e m e s e
lect System Preferences - = - @
= ¢ @ 8
B Click on Network
ee e =
‘86 Network e

W Select Built-in Ethernetinthe ¢ = & @ a
Show pull-down menu = — =

Location: | Automatic I3

Show: | Built-in Ethernet i

m Select Manually inthe Con- — . —— R
DHCP Router
)

figure pull-down menu Configure  Using DHCP

Using BootP
Servers (Optional)

IP Address:
(Provided by DHCP Server}

Subnet Mask: 255.255.255.0

Router: 152.168.0.1 Search Domains (Optional)

DHCP Client ID:

(Optional)
Example: apple.com, earthlink.net
Ethernet Address:
@ Click the lock to prevent further changes. Apply Now
‘@6 Network =)
W =A@ 2
Show Al Displays Sound Network Startup Disk

Location: | _Automatic s j

B Inputthe Static IP Address, = - ,
the Subnet Mask and the Tlr‘_lr’ﬂIP PPPoE | AppleTalk ; Proxies
Router IP Address in the ap- S —
propriate ﬁelds Domain Name Servers (Optional)

IP Address:  192.168.0.2

Subnet Mask: 255.255.255.0

Router: 192.168.01 Search Domains (Optional)

Example: apple.com, earthlink net
Ethernet Address: 00:09:93:75:de:Sa

B Click Apply Now

Aoty How—
(@) Click the lock to prevent further changes. " Apply Now
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Selecting a Dynamic IP Address with Macintosh OSX

B  Go to the Apple Menu and select mHE P om0 s e

System Preferences

B Click on Network

B Select Built-in Ethernet in the
Show pull-down menu

B  Select Using DHCP in the
Configure pull-down menu

B Click Apply Now

B ThelP Address, Subnet
mask, and the Router’s IP
Address will appear in a few

seconds

CXG) System Preferences [=)
W =A@ O
ShowAl | Dispays_ Sound_Network_Starup Disk B B
Personal
Deskop Dok Genenl  imematonal Saeensaver Unieral
e
Hardware
Cobrire— Dialari— i Shi— oA Mot —— ot
Internet & Network
(%) 3
ntemer— eowon oJ) quatme  sn
system
2 @ @ § 4
assic DmeaTime Sofwwre  Speech  SarwpDisk  Users
e
‘86 Network (=]
“« =A@ &
Show All Dgsp\i;'s Sound Netwerk Startup Disk -
Location: | Automatic ‘#j
(Shuw Built-in Ethernet =)
ioxies |
—J Manually £ L
¥ Using DHCP
OSING Boot
Servers (Optional)
1P Address:
(Provided by DHCP Server)
Subnet Mask: 255.255.255.0
Router: 192.168.0.1 Search Domains (Optional)
DHCP Client ID
(Optional)
Example: apple.com, earthlink.net
Ethernet Address:
@ Click the lock to prevent further changes. Apply Now
o

e o Network

=40 3

Show All | Displays Sound Network Startup Disk
Location: | Automatic iz

Show: | Built-in Ethernet [ia )

[rcpiip ) pprok | Appletalk | Proxies |

Configure: | Using DHCP )

Domain Name Servers (Optional)

IP Address: 192.168.0.160
(Provided by DHCP Server}

Subnet Mask: 255.255.255.0

Search Domains

Router: 192.168.0.1

DHCP Client ID:
(ptianal)

(Optional)

Example: apple.com, earthlink.net

Ethernet Address: 00:06:96:79:de:5a

(&) Click the lock to prevent further changes.

' " Apply Now ) '
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Checking the Wireless Connection by Pinging in Windows XP and

2000

m GotoStart >Run > BEE
type cmd. Awindow et e P o B
Similar to thIS one IF:\Documents and Settings\lah43ping 192_168.8.58

ill T Pinging 192.168.0.50 with 32 hytes of data:
Wi appear' ype Rewly fron 192. }ss 3 -8 hytes-32 tine
8 z a it

ping

XXX XXX XXX XXX, s .
where xxx is the IP "P*"a:ﬂ:fm :’a';i‘ n S el eeeond=s,
Address Of the F:\Documents and Settingsslah4>_

Wireless Router or
Access Point. A

good wireless
connection will show
four replies from the
Wireless Router or
Acess Point, as
shown.

Checking the Wireless Connection by Pinging in Windows Me
and 98

B Goto Start > Run % M5-D0S Prompt

> type command.
A window similar to
this will appear.
Type ping

XXX XXX XXX . XXX
where xxx is the IP r
Address of the - anooms
Wireless Router or
Access Point. A
good wireless
connection will
show four replies
from the wireless
router or access
point, as shown.
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Troubleshooting

This Chapter provides solutions to problems that can occur during the installation and
operation of the DI-624 Wireless Broadband Router. We cover various aspects of the
network setup, including the network adapters. Please read the following if you are having
problems.

Note: It is recommended that you use an Ethernet connection to
configure the DI-624 Wireless Broadband Router.

1.The computer used to configure the DI-624 cannot access the
Configuration menu.

B Check that the Ethernet LED on the DI-624 is ON. If the LED is not
ON, check that the cable for the Ethernet connection is securely
inserted.

B Check that the Ethernet Adapter is working properly. Please see
item 3 (Check that the drivers for the network adapters are
installed properly) in this Troubleshooting section to check that
the drivers are loaded properly.

B Checkthat the IP Address is in the same range and subnet as the
DI-624. Please see Checking the IP Address in Windows XP in
the Networking Basics section of this manual.

Note: The IP Address of the DI-624 is 192.168.0.1. All the computers on the
network must have a unique IP Address in the same range, e.g., 192.168.0.x.
Any computers that have identical IP Addresses will not be visible on the
network. They must all have the same subnet mask, e.g., 255.255.255.0

B Do aPing test to make sure that the DI-624 is responding. Go to
Start>Run>Type Command>Type ping 192.168.0.1. Asuccessful
ping will show four replies.

‘ e E\AWINDOWS\System32vcmd.exe HEH

[E:\>ping 192.168.0.1

[Pinging 192.168.8.1 with 32 hytes = Note: |f you have
i changed the default IP

TTL=128

z32
gree=32 Cinedin TTL28 Address, make sure to

168.08.1:

ping the correct IP
Address assigned to the
DI-624.
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Troubleshooting

2. The wireless client cannot access the Internet in the
Infrastructure mode.

Make sure the wireless client is associated and joined with the correct Access
Point. To check this connection: Right-click on the Local Area Connection icon
in the taskbar> select View Available Wireless Networks. The Connect to
Wireless Network screen will appear. Please make sure you have selected the

correct available network, as shown in the illustrations below.

Disable The followaing network[z) are available. To access a network, select

Status
Repair

it from the list. and then click Connect.

Available networks:

i alan ~

o]

Wigw Available Wirelass Networks dan
pen Hetwork Comnections _v
|
.l

If you are having difficulty connecting ta a netwark, click Advanced.

[ Connect l[ Cancel ]

B Check that the IP Address assigned to the wireless adapter is within the

same IP Address range as the access point and gateway. (Since the
DI-624 has an IP Address of 192.168.0.1, wireless adapters must have
an IP Address in the same range, e.g., 192.168.0.x. Each device must
have a unique IP Address; no two devices may have the same IP
Address. The subnet mask must be the same for all the computers on
the network.) To check the IP Address assigned to the wireless adapter,
double-click on the Local Area Connection icon in the taskbar >
select the Support tab and the IP Address will be displayed. (Please
refer to Checking the IP Address in the Networking Basics section of
this manual.)

If it is necessary to assign a Static IP Address to the wireless adapter,
please refer to the appropriate section in Networking Basics. If you are
entering a DNS Server address you must also enter the Default
Gateway Address. (Remember that if you have a DHCP-capable router,
you will not need to assign a Static IP Address. See Networking

Basics: Assigning a Static IP Address.)
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Troubleshooting

3. Check that the drivers for the network adapters are

installed properly.
You may be using different network adapters than those illustrated here, but this
procedure will remain the same, regardless of the type of network adapters you are
USIng. t’) Windows Media Player I

Open
Explore

B’ Control P Search...

Manage
e‘ Conneck
s

':;é Printers 2

Map Metwork Drive, .,
Disconnect Metwork Drive. .

v Show on Desktop

@) Help and|  Rename
m Goto Start > My r) Semndy s
Computer >
Properties i

All Programs D

Turn COff Computer

'start

System Properties

B Select the
Hardware | System Restors 1 Automatic Lpdate R emote |
Tab | General |  Computer Name ¢ Hardweare Advanced

Add Hardware Wizard
i The Add Hardware “Wizard helps you install hardware,

Add Hardware Wizard

Device M anager

B Click Device
Manager

The Device Manager lists all the hardware devices installed
on pour computer, Use the Device Manager to change the
properties of any device.

’ Diriver Sianing ] i Device Manager ;

N et

Hardware profiles provide a way for you to set up and store
different hardware configurations.

Hardware Profiles

[ Hardware Profiles ]

ak l[ Cancel ] Apply




Troubleshooting

B Double-click
on Network
Adapters

B Right-click on D-Link
AirPlus DWL-G650
Wireless Cardbus
Adapter (In this example
we use the DWL-G650;
you may be using other
network adapters, but the
procedure will remain the
same.)

B Select Properties
to check that the
drivers are in-
stalled properly

B LookunderDevice
Status to check that the
device is working

properly

B Click OK

Z¢ Device Manager

File  Action Wew Help
e 2 =R a

= & prTEST
+ ﬁ Batteries

§ Computer

< Disk drives

-_'_é Display adapters
(= Floppy disk contraollers
,ﬂ, Floppy disk drives
(=) 1DE ATASATAPT controllers
‘2z Keyboards

'_')' Mice and other pointing devices

E_,, Modems

] [ [ [ [ [ [ ] [

+- ' Ports (COM & LPT)
+ 9% Processors
+- %), sound, video and game controllers

+ System devices
+ Universal Serial Bus controllers

D-Link AirPlus DWL-G650 Wireless Cardbus Adapter

General | Advanced | Settings | Driver | Resources

=il D-Link AirPlus DWL-G650 Wireless Cardbus Adapter

Device bype: Metwork adapters
Marufacturer: D-Link
Location: PCl busz 5, device 0, function 0

Device statuz

This device is working properly.

If you are having problems with thiz device, click Troubleshoot to
shart the troubleshooter.

Troubleshoot. ..

Device uzage:

Use thiz device [enable] v

l oK. ' Cancel
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Troubleshooting

4. What variables may cause my wireless products
to lose reception?

D-Link products let you access your network from virtually anywhere you want. However,
the positioning of the products within your environment will affect the wireless range.
Please refer to Installation Considerations in the Wireless Basics section of this manual
for further information about the most advantageous placement of your D-Link wireless
products.

5. Why does my wireless connection keep dropping?

B Antenna Orientation- Try different antenna orientations for the DI-624. Try to
keep the antenna at least 6 inches away from the wall or other objects.

W Ifyou are using 2.4GHz cordless phones, X-10 equipment or other home secu-
rity systems, ceiling fans, and lights, your wireless connection will degrade dra-
matically or drop altogether. Try changing the Channel on your Router, Access
Point and Wireless adapter to a different Channel to avoid interference.

B Keep your product away (at least 3-6 feet) from electrical devices that generate
RF noise, like microwaves, Monitors, electric motors, etc.

6. Why can’t | get a wireless connection?

If you have enabled Encryption on the DI-624, you must also enable encryption on all
wireless clients in order to establish a wireless connection.

B For 802.11b, the Encryption settings are: 64, 128, or 256 bit. Make sure that the
encryption bit level is the same on the Router and the Wireless Client.

B Make sure that the SSID on the Router and the Wireless Client are exactly the
same. If they are not, wireless connection will not be established.

B Move the DI-624 and the wireless client into the same room and then test the
wireless connection.

B Disable all security settings. (WEP, MAC Address Control)
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Troubleshooting

6. Why can’t | get a wireless connection? (continued)

Turn off your DI-624 and the client. Turn the DI-624 back on again, and then turn
on the client.

Make sure that all devices are set to Infrastructure mode.

Check that the LED indicators are indicating normal activity. If not, check that the
AC power and Ethernet cables are firmly connected.

Check that the IP Address, subnet mask, gateway and DNS settings are cor-
rectly entered for the network.

If you are using 2.4GHz cordless phones, X-10 equipment or other home security
systems, ceiling fans, and lights, your wireless connection will degrade dramati-
cally or drop altogether. Try changing the Channel on your DI-624, and on all the
devices in your network to avoid interference.

Keep your product away (at least 3-6 feet) from electrical devices that generate
RF noise, like microwaves, Monitors, electric motors, etc.

7. 1 forgot my encryption key.

Reset the DI-624 to its factory default settings and restore the other devices on
your network to their default settings. You may do this by pressing the Reset
button on the back of the unit. You will lose the current configuration settings.
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Troubleshooting

8. Resetting the DI-624 to Factory Default Settings

After you have tried other methods for troubleshooting your network, you may
choose to Reset the DI-624 to the factory default settings. Remember that D-
Link AirPro products network together, out of the box, at the factory default
settings.

Reset

To hard-reset the DI-624 to Factory Default Settings, please do the following:

B | ocate the Reset button on the back of the DI-624
B Use a paper clip to press the Reset button

B Hold for about 10 seconds and then release

B After the DI-624 reboots (this may take a few minutes) it
will be reset to the factory Default settings
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Technical Specifications

Standards
B |EEE802.11g
B |EEE802.11b
B |EEE 802.3
Hm |EEE 802.3u

VPN Pass Through/ Multi-Sessions
B PPTP
B L2TP
m IPSec

Device Management

B Web-Based- Internet Explorer v6 or later; Netscape Navigator v6

or later; or other Java-enabled browsers
B DHCP Server and Client

Advanced Firewall Features

B NAT with VPN Passthrough (Network Address Translation)

MAC Filtering
IP Filtering
URL Filtering
Domain Blocking
Scheduling
Wireless Operating Range
B Indoors — up to 328 feet (100 meters)

B Outdoors — up to 1312 feet (400 meters)

Operating Temperature
B 32°F to 131°F (0°C to 55°C)

Humidity:
B 95% maximum (non-condensing)

Safety and Emissions:
B FCC

Wireless Frequency Range:
B 2.4GHzto2.462GHz
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Technical Specifications

LEDs:
Power

WAN
LAN (10/100)
WLAN (Wireless Connection)

Physical Dimensions:

B L =7.56inches (192mm)
B W =4.65 inches (118mm)
m H=1.22inches (31mm)

Wireless Transmit Power:
B 15dBm *2dB

Security:

B 802.1x

B WPA- WiFi Protected Access
(64-,128-WEP with TKIP, MIC, IV Expansion, Shared Key
Authentication)

External Antenna Type:
B Single detachable reverse SMA

Modulation Technology:
B Orthogonal Frequency Division Multiplexing (OFDM)

Power Input:
B Ext. Power Supply DC 5V, 3.0A

Weight:

m 10.8 oz. (0.3kg)
Warranty:

B 3year
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Technical Specifications

Wireless Data Rates with Automatic Fallback:

Receiver

54 Mbps
48 Mbps
36 Mbps
24 Mbps
18 Mbps
12 Mbps
11 Mbps
9 Mbps
6 Mbps
5.5 Mbps
2 Mbps
1 Mbps

Sensitivity:

54Mbps OFDM, 10% PER, -68dBm
48Mbps OFDM, 10% PER, -68dBm
36Mbps OFDM, 10% PER, -75dBm
24Mbps OFDM, 10% PER, -79dBm
18Mbps OFDM, 10% PER, -82dBm
12Mbps OFDM, 10% PER, -84dBm
11Mbps CCK, 8% PER, -82dBm
9Mbps OFDM, 10% PER, -87dBm
6Mbps OFDM, 10% PER, -88dBm
5.5Mbps CCK, 8% PER, -85dBm
2Mbps QPSK, 8% PER, -86dBm
1Mbps BPSK, 8% PER, -89dBm
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Frequently Asked Questions

Why can’t | access the web based configuration?

When entering the IP Address of the DI-624 (192.168.0.1), you are not connecting to
the Internet or have to be connected to the Internet. The device has the utility built-in

to a ROM chip in the device itself. Your computer must be on the same IP subnet to

connect to the web-based utility.

To resolve difficulties accessing a web utility, please follow the steps below.

Step 1 Verify physical connectivity by checking for solid link lights on the device. If
you do not get a solid link light, try using a different cable or connect to a different
port on the device if possible. If the computer is turned off, the link light may not be
on.

What type of cable should | be using?

The following connections require a Crossover Cable:
Computer to Computer

Computer to Uplink Port

Computer to Access Point

Computer to Print Server

Computer/XBOX/PS2 to DWL-810
Computer/XBOX/PS2 to DWL-900AP+

Uplink Port to Uplink Port (hub/switch)

Normal Port to Normal Port (hub/switch)

The following connections require a Straight-through Cable:
Computer to Residential Gateway/Router

Computer to Normal Port (hub/switch)

Access Point to Normal Port (hub/switch)

Print Server to Normal Port (hub/switch)

Uplink Port to Normal Port (hub/switch)

Rule of Thumb:
"If there is a link light, the cable is right.”

64



Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

What type of cable should | be using? (continued)

What’'s the difference between a crossover cable and a straight-through
cable?

The wiring in crossover and straight-through cables are different. The two types
of cable have different purposes for different
LAN configurations. EIA/TIA 568A/568B

. .. 1 White-Green
define the wiring standards and allow for g gﬁ..tan o
two different wiring color codes as 1 Blue o l4®
illustrated in the following diagram. g ‘(-;‘-:?;;flue
. . 7 White-Brown
*The wires with colored backgrounds may 8 Brown

have white stripes and may be denoted 568A CABLE END
that way in diagrams found elsewhere.

1 White-Orange
. 2 Orange
How to tell straight-through cable from 1 White-Green
. 4 Blue
across_overcable. _ 5 WhieBlue
The main way to tell the difference 6 Green
R ¥ White-Brown
between the two cable types is to compare 8 Brown

the wiring order on the ends of the cable. If
the wiring is the same on both sides, it is
straight-through cable. If one side has opposite wiring, it is a crossover cable.

5688 CABLE END

All you need to remember to properly configure the cables is the pinout order of
the two cable ends and the following rules:

A straight-through cable has identical ends

A crossover cable has different ends

It makes no functional difference which standard you follow for straight-through
cable ends, as long as both ends are the same. You can start a crossover cable
with either standard as long as the other end is the other standard. It makes no
functional difference which end is which. The order in which you pin the cable is
important. Using a pattern other than what is specified in the above diagram
could cause connection problems.

When to use a crossover cable and when to use a straight-through cable:
Computer to Computer — Crossover

Computer to an normal port on a Hub/Switch — Straight-through

Computer to an uplink port on a Hub/Switch - Crossover

Hub/Switch uplink port to another Hub/Switch uplink port — Crossover
Hub/Switch uplink port to another Hub/Switch normal port - Straight-through
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 2 Disable any Internet security software running on the computer. Software
firewalls like Zone Alarm, Black Ice, Sygate, Norton Personal Firewall, etc. might
block access to the configuration pages. Check the help files included with your
firewall software for more information on disabling or configuring it.

Step 3 Configure your Internet settings.

Go to Start>Settings>Control Panel. Double click Tmemmavesers |
the Internet Options Icon. From the Security tab, e ——
click the button to restore the settings to their Tﬁ e
defaults. i

Click to the Connection tab and set the dial-
up option to Never Dial a Connection. Click

the LAN Settings button

Eoy
) 3pply (0 Gakup comnectons. AN Settings.
ove for delup setings.

Nothing should be checked. Click OK

- Use a prosyserver foryou LAN (These setings vl ot apely o
diakup o1 VPN cormections).

Go to the Advanced tab and click the
button to restore these settings to their

defaults

Click OK. Go to the desktop and close any open
windows




Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 Check your IP Address. Your computer must have an IP Address in the same
range of the device you are attempting to configure. Most D-Link devices use the
192.168.0.X range.

How can | find my IP Address in Windows 95, 98, or
ME?

Step 1 Click on Start, then click on Run.

Step 2 The Run Dialogue Box will appear. Type winipcfg in the window as shown
then click OK.
Run 2 1]

Tupe the name of & program, folder, or document, and
windows will open it for yo.

Open: |winipcfg j

0k i Cancel | Browse... I

Step 3 The IP Configuration window will appear, displaying your Ethernet
Adapter Information.

M Select your adapter from the drop down menu.

M If you do not see your adapter in the drop down menu, your adapter is
not properly installed.

IP Configuration &= &3

— Ethernet Adapter Infoimation

|PPP Adapter.
Adapter Address |1 Tk DFE-550124 10100 Adapter

IP Address 0.0.0.0
Subnet Mask. 0.0.00
Detault Gateway ,7

ok I EElease | REmsw |

Feleaze Al | Renew All | Hore Info »> |

Step 4 After selecting your adapter, it will display your IP Address, subnet
mask, and default gateway.
Step 5 Click OK to close the IP Configuration window
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 (continued) Check your IP Address. Your computer must have an IP Address

in the same range of the device you are attempting to configure. Most D-Link devices
use the 192.168.0.X range.

How can | find my IP Address in Windows 2000/XP?

Step 1 Click on Start and select Run.

Step 2 Type cmd then click OK.
Run [1] x

= Twpe the name of a program, folder, document, or
Internet resource, and Windows will open it Far wau.

Opern; ' cmci |

[ Ok H Cancel H Browse, .. ]

Step 3 From the Command Prompt, enter ipconfig. It will return your IP
Address, subnet mask, and default gateway

NT", system32',CMD.EXE

icrosoft Windows 2008 [Uersion 5.@A.21951
CC» Copyright 1985-2808@ Microsoft Corp.

D:~>ipconfig
Windows 2888 IP Configuration
Ethernet adapter Local Area Connection:

Connection—specific DNS Suffix . =
IP Address. . . . . . . . . . . . = 192.168.68.174

Subnet Mask T 255.255.255.8
Default Gateway : 192.168.8.1

Step 4 Type exit to close the command prompt.
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 (continued) Check your IP Address. Your computer must have an IP Address

in the same range of the device you are attempting to configure. Most D-Link devices
use the 192.168.0.X range.

Make sure you take note of your computer’s Default Gateway IP Address. The Default
Gateway is the IP Address of the D-Link router. By default, it should be 192.168.0.1.

How can | assign a Static IP Address in Windows XP?

Step 1
Click on Start > Control Panel > Network and Internet Connections >
Network connections.

Step 2 See Step 2 for Windows 2000 and continue from there.

How can | assign a Static IP Address in Windows 20007

Step 1 Right-click on My Network
Places and select Properties.

Advanced  Help
| Qsewsh Guroiters B 05 & X o0 | E-

twork and Dial-up Cor

Step 2 Right-click on the Local Networl and Dist-up
Area Connection which represents
your network card and select

i cre o s
H Adapter
Properties.
2%
Conigt
Camponents checked are used by this connection
nghllght |nternet Protocol (TCP/ ] 42} File and Printer Sharing for Miciosoft Networks -]
W~ Metwark Monitar Driver
. . Intemet Pratocol (TCP/IP]
IP) and click Properties. -
p 4 D
Install Urinetall | Properies |
i~ Description
n Control PratacalAlntemet Pratacol. The default
tocal that provi ication
nnected networks.
¥ Showican in taskbar when connected
[i'3 Cancel
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

How can | assign a Static IP Address in Windows 20007

(continued)

Click Use the following IP Address and gy 2%
enter an IP Address that is on the same General
subnet as the LAN IP Address on your e e e e e
router. Example: If the router’s LAN IP e Rt
Address is 192.168.0.1, make your IP © Dbt an P adetess auonalialy
Address 192.168.0.X where X = 2-99. =
Make sure that the number you choose is Subracmask [5% =5 2% 0
not in use on the network. Defaul gatonay: [T dee. 0 1
£ Obtain DNS server address automatically

Set the Default Gateway to be the R e e e
same as the LAN IP Address of your S W
router (192.168.0.1).

Adyanced
Set the Primary DNS to be the same as o

the LAN IP address of your router
(192.168.0.1).

The Secondary DNS is not needed or enter a DNS server from your ISP.

Click OK twice. You may be asked if you want to reboot your computer. Click

Yes.

How can | assign a Static IP
Address in Windows 98/Me?

Step 1 From the desktop, right-click on the
Network Neigborhood icon (Win ME - My

Network Places) and select Properties

Highlight TCP/IP and click the Properties
button. If you have more than 1 adapter,
then there will be a TCP/IP “Binding” for
each adapter. Highlight TCP/IP > (your
network adapter) and then click

Properties.

Metwork EHE

Configunation | |dentfication | Access Contiol |

The following network components are installed

Client for Microsoft Networks
D Link DFE 5307+ PCI Fast Ethemet Adapter (Fev 4]

Fopeties |

Femove |

Add. |

Primary Network Logon,

[Ciert tor Microsaft Networks =l
File and Print Sharing...
Description
TCPAR is the protocel you use to connect to the Intemet and
wide-area networks
e
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

How can | assign a Static IP Address in Windows

98/Me? (continued)
Step 2 Click Specify an IP Address.

Enter in an IP Address that is on the same
subnet as the LAN IP Address on your router.
Example: If the router’s LAN IP Address is
192.168.0.1, make your IP Address
192.168.0.X where X is between 2-99. Make
sure that the number you choose is not in
use on the network.

Step 3 Click on the Gateway tab.

Enter the LAN IP Address of your router
here (192.168.0.1).

Click Add when finished.

Step 4 Click on the DNS Configuration tab.

Click Enable DNS. Type in a Host (can be
any word). Under DNS server search order,
enter the LAN IP Address of your router
(192.168.0.1). Click Add.

Step 5 Click OK twice.

When prompted to reboot your computer,
click Yes.

After you reboot, the computer will now have
a static, private IP Address.

Step 5 Access the web management. Open your web
browser and enter the IP Address of your D-Link device in
the address bar. This should open the login page for the web

" Dbtain an IP address automatically

& Bpeciy an P address]

192.168. 0 . 10

[P Addess

Advance d | Nemios |
| Witis Corfiguration | 1P Address

e Installed Gateway list wil be the default
he lst will b the ordler in which thest

New gateway

192.168. 0 . 1 Add

192.168.0.1 Remave

TCP/IP Properties 2] x]

Advance d | nNemiDs |
| WINS Configwation | IF Address

isable
[~ Enable DNS

ot [ryting Doman |

DNS Server Search 0t s——
192.168. 0 . 1 Add

Domain Suffix Search Oider

management. Follow instructions to login and complete the configuration.
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Frequently Asked Questions (continued)

How can | setup my router to work with a Cable modem connection?

Dynamic Cable connection
(IEAT&T-BI, Cox, Adelphia, Rogers, Roadrunner, Charter, and Comcast).

Note: Please configure the router with the computer that was last connected directly
to the cable modem.

Step 1 Log into the web based configuration by typing in the IP Address of the router
(default:192.168.0.1) in your web browser. The username is admin (all lowercase) and

the password is blank (nothing). 2]
? Please ype your user name and password.

Step 2 Click the Home tab and click the Sim 15216801

WAN button. Dynamic IP Address is the Ream DS

default value, however, if Dynamic IP Address UserName  [sdmn

is not selected as the WAN type, select Posword |

Dynamic IP Address by clicking on the radio I Save tis password nyour password e

button. Click Clone Mac Address. Click on Carcel |

Apply and then Continue to save the

changes.

TAir}Pﬁ |U?‘E %

High-Speed 2.4GHz Wireless Router

DI-B;ZIl-

Home Advanced 'i‘ools Status ' Help

Flease selecd the appropriata opSon o connect bo your IEP.

Wizard o

& Dynamic (P Adgress Choose this oplion o oblain an IP address aulomaticalby from
your ISP, (Far most Cable modem users)

| /e

" Wircless  Stafic IP Address Choose this oplion o 81 stalic 1P infarmation provided b you
b your ISP
 PPROE Chooze this option ifyour |1SF uses FPPOE. (For most DEL
wEers)
© Dihers FFTF and BigFond Catde
= ppTR (for Europe use onh)
Hosl Name |D|-62-1 {optionaly
WAL Address [0 o .Jcs -3 [0 .[DD toptionan
Clona MAC Address I
2 90

Apply Cancel Help
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Frequently Asked Questions (continued)

How can | setup my router to work with a Cable modem connection?
(continued)

Step 3 Power cycle the cable modem and router:

Turn the cable modem off (first) . Turn the router off Leave them off for 2 minutes.**
Turn the cable modem on (first). Wait until you get a solid cable light on the cable
modem. Turn the router on. Wait 30 seconds.

** |f you have a Motorola (Surf Board) modem, leave off for at least 5 minutes.

Step 4 Follow step 1 again and log back into the web configuration. Click the Status
tab and click the Device Info button. If you do not already have a public IP Address

under the WAN heading, click on the DHCP Renew and Continue buttons.

Static Cable Connection
Step 1 Log into the web based configuration by
typing in the IP Address of the router
(default:192.168.0.1) in your web browser. The

B S|

{j.) Pleaz lype your user name and pazsword.
° s

e 19216801
username is admin (all lowercase) and the password o OS2
. . jsecName [l
is blank (nothing). —
. . ™ Save this password in your pasword ket
Step 2 Click the Home tab and click the WAN ol
button. Select Static IP Address and enter your
static settings obtained from
the ISP in the fields provided. Z .
D-Link ARl G-

If you do not know your High-Speed 2.4GHz Wireless Router
settings, you must contact e (O Advonced _Tools __ Status__Help
your | S P ;m. age seloct the appropriate apon 1o cannect 1o your ISP,

 Dymarnic IP Address CnoogngFls aps nr;ICn oumaln aun IPaUure:s automatically fram

your | or mosi Cable modem users,
& Siatic IP Address nc';llva‘:'o“srelslr;s oporn 1o 361 static P information prowded b you
. © PPPOE Chansa this apton ifyour ISP uses PPPoE. (For most DSL
Step 3 CIICk On Apply and € Others ::l’::ndaugmnncable
then click Continue to save - torEuiope use or
the changes. —
A P Address BA52 120 (azsigned by your ISF)

Step 4 Click the Status tab e P —
and click the Device Info pimanONsAddess OO0
button. Your IP Address sscongayoNgAgasss  [020D foponsn
information will be displayed 2 0O
under the WAN heading. Aoy Cancel Helo
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Frequently Asked Questions (continued)

How can | setup my router to work with Earthlink DSL or any PPPoE
connection?

Make sure you disable or uninstall any PPPoE software such as WinPoet or Enternet
300 from your computer or you will not be able to connect to the Internet.

Step 1 Upgrade Firmware if needed.

(Please visit the D-Link tech support website at: http://support.dlink.com for the latest
firmware upgrade information.)

Step 2 Take a paperclip and perform a hard reset. With the unit on, use a paperclip
and hold down the reset button on the back of the unit for 10 seconds. Release it and
the router will recycle, the lights will blink, and then stabilize.

Step 3 After the router stabilizes, open your browser and enter 192.168.0.1 into the
address window and hit the Enter key. When the password dialog box appears, enter
the username admin and leave the password blank. Click OK.

If the password dialog box does not come up repeat Step 2.
Note: Do not run Wizard.
Step 4 Click on the WAN tab on left-hand side of the screen. Select PPPoE.

Step 5 Select Dynamic PPPoE (unless your ISP supplied you with a static IP
Address).

Step 6 Inthe username field enter ELN/username@earthlink.net and your
password, where username is your own username.

For SBC Global users, enter username@sbcglobal.net.
For Ameritech users, enter username@ameritech.net.
For BellSouth users, enter username@bellsouth.net.

For Mindspring users, enter username@mindspring.com.
For most other ISPs, enter username.

Step 7 Maximum Idle Time should be set to zero. Set MTU to 1492, unless
specified by your ISP, and set Autoreconnect to Enabled.

Note: If you experience problems accessing certain websites and/or email issues,

please set the MTU to a lower number such as 1472, 1452, etc. Contact your ISP for
more information and the proper MTU setting for your connection.
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Frequently Asked Questions (continued)

How can | setup my router to work with Earthlink DSL or any PPPoE
connection? (continued)

Step 8 Click Apply. When prompted, click Continue. Once the screen refreshes,
unplug the power to the D-Link router.

Step 9 Turn off your DSL modem for 2-3 minutes. Turn back on. Once the modem
has established a link to your ISP, plug the power back into the D-Link router. Wait
about 30 seconds and log back into the router.

Step 10 Click on the Status tab in the web configuration where you can view the
device info. Under WAN, click Connect. Click Continue when prompted. You should
now see that the device info will show an IP Address, verifying that the device has
connected to a server and has been assigned an IP Address.

Can | use my D-Link Broadband Router to share my Internet
connection provided by AOL DSL Plus?

In most cases yes. AOL DSL+ may use PPPoE for authentication bypassing the
client software. If this is the case, then our routers will work with this service. Please
contact AOL if you are not sure.

To set up your router:

Step 1 Log into the web-based configuration (192.168.0.1) and configure the WAN
side to use PPPoOE.

Step 2 Enter your screen name followed by @aol.com for the user name. Enter your
AOL password in the password box.

Step 3 You will have to set the MTU to 1400. AOL DSL does not allow for anything
higher than 1400.

Step 4 Apply settings.

Step 5 Recycle the power to the modem for 1 minute and then recycle power to the
router. Allow 1 to 2 minutes to connect.

If you connect to the Internet with a different internet service provider and want to use
the AOL software, you can do that without configuring the router’s firewall settings.
You need to configure the AOL software to connect using TCP/IP.

Go to http://www.aol.com for more specific configuration information of their software.
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Frequently Asked Questions (continued)

How do | open ports on my router?

To allow traffic from the internet to enter your local network, you will need to open up
ports or the router will block the request.

Step 1 Open your web browser
and enter the |P AddreSS Of Wirtual Server is used to allow Internet users access to LAN services.
your D-Link router & Enabled © Disabled
(192.168.0.1). Enter username Name [pcanywharal Clear |
(admin) and your password Private P [1321680100
(blank by default). Protocol Type  [UDP ]

Private Port |22—
Step 2 Click on Advanced on Public ot [2
top and then click Virtual Sehedule  Bwaye
Server on the left side. € From time [00 =] . [00 =] [am =] 1o [00=] - [o0 =] [an =]
Step 3 Check Enabled to e Sl S

activate entry.
Step 4 Enter a name for your virtual server entry.

Step 5 Next to Private IP, enter the IP Address of the computer on your local
network that you want to allow the incoming service to.

Step 6 Choose Protocol Type - either TCP, UDP, or both. If you are not sure, select
both.

Step 7 Enter the port information next to Private Port and Public Port. The private
and public ports are usually the same. The public port is the port seen from the WAN
side, and the private port is the port being used by the application on the computer
within your local network.

Step 8 Enter the Schedule information.
Step 9 Click Apply and then click Continue.

Note: Make sure DMZ host is disabled. If DMZ is enabled, it will disable all Virtual
Server entries.

Because our routers use NAT (Network Address Translation), you can only open a
specific port to one computer at a time. For example: If you have 2 web servers on
your network, you cannot open port 80 to both computers. You will need to configure
1 of the web servers to use port 81. Now you can open port 80 to the first computer
and then open port 81 to the other computer.
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Frequently Asked Questions (continued)

What is DMZ?

Demilitarized Zone:

In computer networks, a DMZ (demilitarized zone) is a computer host or small
network inserted as a neutral zone between a company’s private network and the
outside public network. It prevents outside users from getting direct access to a
server that has company data. (The term comes from the geographic buffer zone that
was set up between North Korea and South Korea following the UN police action in
the early 1950s.) ADMZ is an optional and more secure approach to a firewall and
effectively acts as a proxy server as well.

In a typical DMZ configuration for a small company, a separate computer (or host in
network terms) receives requests from users within the private network for access to
Web sites or other companies accessible on the public network. The DMZ host then
initiates sessions for these requests on the public network. However, the DMZ host is
not able to initiate a session back into the private network. It can only forward packets
that have already been requested.

Users of the public network outside the company can access only the DMZ host. The
DMZ may typically also have the company’s Web pages so these could be served to
the outside world. However, the DMZ provides access to no other company data. In
the event that an outside user penetrated the DMZ hosts security, the Web pages
might be corrupted but no other company information would be exposed. D-Link, a
leading maker of routers, is one company that sells products designed for setting up

abDMZ

How do | configure the DMZ Host?

The DMZ feature allows you to forward all incoming ports to one computer on the local
network. The DMZ, or Demilitarized Zone, will allow the specified computer to be
exposed to the Internet. DMZ is useful when a certain application or game does not
work through the firewall. The computer that is configured for DMZ will be completely
vulnerable on the Internet, so itis suggested that you try opening ports from the
Virtual Server or Firewall settings before using DMZ.

Step 1 Find the IP address of the computer you want to use as the DMZ host.
To find out how to locate the IP Address of the computer in Windows XP/2000/ME/9x

or Macintosh operating systems please refer to Step 4 of the first question in this
section (Frequently Asked Questions).
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Frequently Asked Questions (continued)

How do | configure the DMZ Host? (continued)

Step 2 Log into the web based configuration o
of the router (default:192.168.0.1) in your web b

lowercase) and the password is blank (nothing)

Step 3 Click the Advanced tab and then click

)
E ;

Access Poink

User name:

Q adrrl]lin bl

Password:

[CIremember my password

[ o

H Cancel ] d

type in the IP Address you found in step 1.

Step 4 Click Apply
and then Continue to
save the changes.

D-Link

Building Networks for People

DI-624 I

“AirrPlus -
XorrenmE,
High-Speed 2.4GHz Wireless Router

¢ Status. - Help

Note: When DMZ is
enabled, Virtual Server
settings will still be
effective. Remember,
you cannot forward the
same port to multiple
IP Addresses, so the
Virtual Server settings
will take priority over

DMZ settings.

“Virtual Server
* Applications
E——

Filters

' Firewall

Performance

il
[_se]

[ __Home WEVLYEIEE Tools
IR
DMZ (Demilitarized Zone) is used to allow a single computer on the LAN to be exposed to
the Internet
€ Enabled @ Disabled
IP Address 192 168.0.0
9 00

Apply Cancel Help
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Frequently Asked Questions (continued)

How do | open a range of ports on my DI-624 using Firewall rules?

Step 1 Access the router’s web configuration by entering the router’s IP Address in
your web browser. The default IP Address is 192.168.0.1. Login using your password.
The default username is “admin” and the password is blank.

If you are having difficulty accessing web management, please see the first question
in this section.

Step 2 From the web management Home page, click the Advanced tab then click
the Firewall button.

Step 3 Clickon D-Link “AirPlus =
Enabled and type in Wrremels

a name for the new High-Speed 2.4GHz Wireless Router
rule. || S acvonced T
Step 4 ChOOSe WAN Flrént;a\\ R;.;I.es can be used to allow or deny traffic fror passing through the D624
as the Source and Yemoee € Enatled © Disabled

MName Clear
Applications Action @ Allow © Deny
Interface IP Range Stat IP Range End Protocol Port Range

enter arange of IP
Addresses out on the

L HEa

internet that you — soce [ | |

would like this rule el |; mﬂ, I (R | I .
applied to. If you & om0 0 R« -
would like this rule to day [Sun =] 1o [Son 5]

allow all internet [V I +)
users to be able to gl aant s a2 Cancel Help
access these ports, Performance I Allow  Allowto Ping WAN port WANS LAN192.188.01  IcMPg  [4
then put an Asterisk _ o T B2 P

in the first box and
leave the second box

empty.
Step 5 Select LAN as the Destination and enter the IP Address of the computer on
your local network that you want to allow the incoming service to. This will not work
with a range of IP Addresses.

Step 6 Enter the port or range of ports that are required to be open for the incoming
service.

Step 7 Click Apply and then click Continue.

Note: Make sure DMZ host is disabled.

Because our routers use NAT (Network Address Translation), you can only open a
specific port to one computer at a time. For example: If you have 2 web servers on
your network, you cannot open port 80 to both computers. You will need to configure
1 of the web servers to use port 81. Now you can open port 80 to the first computer

and then open port 81 to the other computer. 79




Frequently Asked Questions (continued)

What are virtual servers?

A Virtual Server is defined as a service port, and all requests to this port will be
redirected to the computer specified by the server IP. For example, if you have an FTP
Server (port 21) at 192.168.0.5, a Web server (port 80) at 192.168.0.6, and a VPN
server at 192.168.0.7, then you need to specify the following virtual server mapping

table:

21
80
1723

192.168.0.5 X
192.168.0.6 X
192.168.0.7 X

How do | use PC Anywhere with my DI-624 router?

You will need to open 3 ports in the Virtual Server section of your D-Link router.

Step 1 Open your web browser and enter the IP Address of the router (192.168.0.1).

Step 2 Click on Advanced at the top and then click Virtual Server on the left side.

Step 3 Enter the
information as seen
below. The Private IP
is the IP Address of the
computer on your local
network that you want to
connect to.

Step 4 The first entry
will read as shown here:

Step 5 Click Apply

and then click Continue.

Virtual Server
Yirtual Server is used to allow Internet users access to LAN services.

& Enabled € Disabled

Mame [peanywhere M
Private IP IW
Protocol Type ITP;,
Private Part |22—
Public Port 22
Schedule & Always
€ From time [00 x| - [00 7| [AM > 1o [00 =] - [00 7| [AM =]
day [Sun =] to[Sun =]
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Frequently Asked Questions (continued)

How do | use PC Anywhere with my DI-624 router? (continued)

Step 6 Create
a second entry Wittual Server is used to allow Intermet users access to LAN semvices.

as shown here: & Enabled © Disabled

Marne Ipu:anywherez Clear |
Private IP I192.'|EB.D.'I 0o

Pratocal Type ITCP vl
Private Port |5531

. Public P [5631
Step 7 Click ublie For
Apply and then Schedule = Always
click Continue. C From time |00 x| - [00 =] [AM =] ta [00 =] - 00 =] [AM ¥
dayISun 'lmlSun vl

Step 8 Create _ i _
a third and final irtual Server is used to allow Internet users access to LAN services.

entry as shown

. & Enabled O Disabled
here:

Marng |pcanywher93 Clear |
Private IP I192.1EB.D.1 a0

Pratacal Type Im
Private Port W
Public Port  [BR3z
Schedule & Always
 From timeluuj : IUUj IAMj TDIDDj ;|Dﬂj I’Wj
day m to m

Step 9 Click Apply and then click Continue.

Step 10 Run PCAnywhere from the remote site and use the WAN IP Address of the

router, not your computer’s IP Address. 81



Frequently Asked Questions (continued)

How can | use eDonkey behind my D-Link Router?

You must open ports on your router to allow incoming traffic while using eDonkey.

eDonkey uses three ports (4 if using CLI):

4661 (TCP) To connect with a server

4662 (TCP) To connect with other clients

4665 (UDP) To communicate with servers other than the one you are connected to.
4663 (TCP) *Used with the command line (CLI) client when it is configured to allow
remote connections. This is the case when using a Graphical Interface (such as the

Java Interface) with the client.

Step 1 Open your web browser and enter the IP Address of your router
(192.168.0.1). Enter username (admin) and your password (leave blank).

Step 2 Click on Advanced and then click Firewall.

Step 3 Create a
new firewall rule:

Click Enabled. rAlr}PE lus G-
Enter aname High-Speed 2.4GHz Wireless Router
(edonkey).

Click Allow. [_tome JVVVTLUSIN Tools  Status __ Help |
NeXt to Source’ Firgwall Rulos can ba usad 10 alkew or dony frafic from passing through 1he DEE24
SeIeCtWAN CRp & Enabled T Disabled

under interface. In W ]

Action & Allrw © Deny

the first box,
enter an *. Leave Interface IF Range Start P Range Erd  Protocol Pod Range
Sowca |NANj|‘

[
P—
the second box s Destination [LAM =] [192.166.0.100 = =[qeen . [46ss

empty. Schedule  © Always
Next to € From time [00 =] ; [00 =] [AM =] 1o [00 =] : oo =] [ =]
Destination, day [Sun = 1[5 2]

@ 90
Apply Cancel Help

Action Name Sgurce  Destination Pratocol

select LAN under
interface. Enter

[E B

the IP Address of Performancs F Allow  Allow o Fing WAN pad WAN® LAM19216801  ICMPE |4
F Dony Default LA P o

the computeryou e Do e o -

are running

eDonkey from.

Leave the second

box empty. Under Protocol, select *. In the port range boxes, enter 4661 in the first
box and then 4665 in the second box. Click Always or set a schedule.

Step 4 Click Apply and then Continue.
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Frequently Asked Questions (continued)

How do | set up my router for SOCOM on my Playstation 27?

To allow you to play SOCOM and hear audio, you must download the latest firmware
for the router (if needed), enable Game Mode, and open port 6869 to the IP Address of
your Playstation.

Step 1 Upgrade firmware (follow link above).

Step 2 Open your web browser and enter the IP Address of the router (192.168.0.1).
Enter username (admin) and your password (blank by default).

Step 3 Click on the Advanced tab and then click on Virtual Server on the left side.

Step 4 You will now create a new Virtual Server entry. Click Enabled and enter a
name (socom). Enter the IP Address of your Playstation for Private IP.

Step 5 For Protocol Type select Both. Enter 6869 for both the Private Port and
Public Port. Click Always. Click Apply to save changes and then Continue

m]?a;!:d}gc}nl& 74”5%:%'5'—;‘,55"
High-Speed 2.4GHz Wireless Router

" Home BLCLOTVER Tools  Status Help

ey |

Yittual Server is used to allow Internet users access to LAN semvices.

@® Enabled © Disabled

Narne ['socom Clar |
Applications Private |P 192.168.0.100
Protocol Type  |Both =

[10G

Filters Private Port 6869
Public Port 6869
Firewall Schedule ® Always
€ From time [00 =] [00°=] [0 =] 10 [007=] . [00 =] [am =]
DMZ day Sun *|tg|Sun =
-
e 9 Q0O
Performance . J
rtual Servers List Apply Cancel Help
Marme Private IP Protocal Schedule
[T Virtual Serer FTP 0.000 TCR 21721 always Eii|
T ‘irtual Server HTTP 0000 TCP B0/80 ahways [Ei |
T Virtual Server HTTPS 0.000 TCP 4434443 always Eii|
I Witual Sever DNS 00nn UDP 53/53 always B |

Step 6 Click on the Tools tab and then Misc on the left side.

Step 7 Make sure Gaming Mode is Enabled. If not, click Enabled. Click Apply
and then Continue. 83



Frequently Asked Questions (continued)

How can | use Gamespy behind my D-Link router?

Step 1 Open your web browser and enter the IP Address of the router (192.168.0.1).
Enter admin for the username and your password (blank by default).

Step 2 Click on the Advanced tab and then click Virtual Server on the left side.

Step 3 You will create 2 entries.
Step 4 Click Enabled and enter
Settings:

NAME - Gamespyl

PRIVATE IP - The IP
Address of your computer
that you are running
Gamespy from.

PROTOCOL TYPE - Both

PRIVATE PORT - 3783
PUBLIC PORT - 3783
SCHEDULE - Always.

Click Apply and then continue

Step 5 Enter 2nd entry:
Click Enabled

NAME - Gamespy?2

PRIVATE IP - The IP
Address of your computer
that youare running
Gamespy from.

PROTOCOL TYPE - Both
PRIVATE PORT - 6500
PUBLIC PORT - 6500
SCHEDULE - Always.

Click Apply and then continue.

D-Link

Bullding Networks for People

———

Applications

Filters

—

Firewall

L) S

DMz

[

Performance

D-Link

Building Networks for People

e

Applications
T E—
Filters

—

Firewall

D

HEREe

Performance

Ulllr',P5 Iusﬁ, =5~

High-Speed 2.4GHz Wireless Router

BTN Advanced PTE Status____Help

Virtual Senver is used to allow Internet users access to LAN sewices.
@ Enabled © Disabled
Mame gamespyl Clear
Private IP 192.168.0.100
Protocol Type  [TCP =
Private Port [3783
Public Part  [3783
Schedule ® Always
€ From time [00 =] - [00 =] [AM =] to [0 =] . [o0 =] [am ]
day [5un =] 40 [Sun =]

@ 90
ual Servers Li: Apply Cancel Help
Narme Private [P Protocal Schedule

™ Virtual Server FTP 0.0.0.0 TCR 21121 abways I} ]
T Wirtual Server HTTP o0.ooo TCP 80/80 abways [E| ]
= Vittual Server HTTPS 0000 TCP 443/443 always [Ei7]
T Wittual Server DNS 00.00 UDP 53/53 abways I ]

“ArPlus -
ICGrenE
High-Speed 2.4GHz Wireless Router

[ Home JWEVLSEE Tools Status____ Help

Virtual Server is used to allow Internet users access to LAN senices.

® Enabled © Disabled

Mame gamespy2 Clear |
Private IP 192.168.0.100
Protocol Type  [Both =
Private Port [6500
Public Patt [6500
Schedule ® Ahways
© From time [00 =] : [00 =] [am =] 1o [00 =] - [00 =] [am =]
day[Sun =] 1o [Bun =
2 9O
rtual Servers Li Apply Cancel Help
Narne Private [P Protocal Schedule
7 Virtual Server FTR 0000 TCP 21121 atways [E]i]
T Wirtual Server HTTP o0.ooo TCP 80/80 abways [E| ]
™ Vitual Server HTTPS 0.000 TCP 4434443 aways [0
UDP 6353 aways  [HH

T Virtual Server DNS 00.00
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Frequently Asked Questions (continued)

How do | configure my router for KaZaA and Grokster?

The following is for KaZaA, Grokster, and others using the FastTrack P2P file sharing
system.

In most cases, you do not have to configure anything on the router or on the Kazaa
software. If you are having problems, please follow steps below:

Step 1 Enter the IP Address of your router in a web browser (192.168.0.1).
Step 2 Enter your username (admin) and your password (blank by default).
Step 3 Click on Advanced and then click Virtual Server.

Step 4 Click Enabled and then enter a Name (kazaa for example).

Step 5 Enter the IP Address of the computer you are running KaZaA from in the
Private IP box. Select TCP for the Protocol Type.

Step 6 Enter 1214 in the Private and Public Port boxes. Click Always under
schedule or set a time range. Click Apply.

“home BTNV Tools  Status  Helo

Winual Server is used to allow Interned users access to LAN semaces.

& Enabled T Digabled

Mama [kazas Clear I
Private IP 192 168.0.100
Protocol Type |TCF TI

Prvate Port W
Public Port W
Schedule ® Always
& From time [00.2] : [0072] [ =] 1o [00] - [60.2] [ =]

day ISun TI o |Sun -

Make sure that you did not enable proxy/firewall in the KaZaA software.
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Frequently Asked Questions (continued)

How do | configure my router to play Warcraft 3?

You must open ports on your router to allow incoming traffic while hosting a game in
Warcraft 3. To play a game, you do not have to configure your router.

Warcraft 3 (Battlenet) uses port 6112.

For the DI-604, DI-614+. DI-624,
DI-754, DI-764, or DI-774:

D Link ArRlus -
Step 1 Open your web browser x| s e e
[ Home BTTUTVER Tools Status Help
and enter the IP Address of your - :
router (192.168.0'1). Entel’ Virtual Sewer is u;edEtn Z:\n:/\:ml;net;s:rs accese to LAN semices.
username (admin) and your R - I — |
Py Private IP X .
password (leave blank). NS =
Private Port  [6112
. Public Port 6112
Step 2 Click on Advanced and sovis oA agEs
then click Virtual Server. — e W
) e @ 90
Step 3 Create a new entry: Click E o Ao conce e
Enabled. Enter a name L R A T
(warcraft3). Private IP - Enter the e ey mEE wesm 5 AR

IP Address of the computer you

want to host the game. Select

Both for Protocol Type Enter 6112 for both Private Port and Public Port Click Always
or set a schedule.

Step 4 Click Apply and then Continue.

Note: If you want multiple computers from you LAN to play in the same game that
you are hosting, then repeat the steps above and enter the IP Addresses of the other
computers. You will need to change ports. Computer #2 can use port 6113, computer
#3 can use 6114, and so on.

You will need to change the port information within the Warcraft 3 software for
computers #2 and up.

Configure the Game Port information on each computer:
Start Warcraft 3 on each computer, click Options > Gameplay. Scroll down and you

should see Game Port. Enter the port number as you entered in the above steps.
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Frequently Asked Questions (continued)

How do | use NetMeeting with my D-Link Router?

Unlike most TCP/IP applications, NetMeeting uses DYNAMIC PORTS instead of
STATIC PORTS. That means that each NetMeeting connection is somewhat different
than the last. For instance, the HTTP web site application uses port 80. NetMeeting
can use any of over 60,000 different ports.

All broadband routers using (only) standard NAT and all internet sharing programs like
Microsoft ICS that use (only) standard NAT will NOT work with NetMeeting or other
h.323 software packages.

The solution is to put the router in DMZ.

Note: Afew hardware manufacturers have taken it on themselves to actually provide
H.323 compatibility. This is not an easy task since the router must search each
incoming packet for signs that it might be a netmeeting packet. This is a whole lot
more work than a router normally does and may actually be a weak point in the
firewall. D-Link is not one of the manufacturers.

To read more on this visit http://www.HomenetHelp.com

How do | set up my router to use iChat? -for Macintosh users-

You must open ports on your router to allow incoming traffic while using iChat.
iChat uses the following ports: 5060 (UDP) 5190 (TCP) File Sharing 16384-16403
(UDP) To video conference with other clients

Step 1 Open your web browser and enter the IP Address of your router
(192.168.0.1). Enter username (admin) and your password (leave blank).

Step 2 Click on Advanced and then click Firewall.
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Frequently Asked Questions (continued)

(continued)

How do | set up my router to use iChat? -for Macintosh users-

Step 3 Create anew
firewall rule:

Click Enabled.
Enter aname
(ichatl).

Click Allow.
Next to Source,
select WAN under
interface.

In the first box,
enter an *.

Leave the second
box empty.

Next to
Destination,
select LAN under
interface.

Enter the IP
Address of the

D-Link

Euilding Metworks for People

Virtu! Sarver

fr———

Apeications.

Fillers

i Bl

DMZ

Performande

[

TAIF} 95 us i

High-Speed 2.4GHz Wireless Router

irewall Rules
Firewall Rudes can be used 1o allow or deny trafic from passing through the DEE24

® Ensbled © Disabled

ame I..;nul— Claar
Aetion & pligw © Deny
kterisce P Range Start 1 Range End  Proiocol Port Range
Source |WN‘-Jj|‘ |
Desfination [LAN =] [182.168.0100 | [uor ke [

Schedde & Abways

© Froen time [00 =] - [08 =] [A0 =] o [00 =] - [00=] [ =]

day [Sun =] g |Sun =
@ 00
will Rules List Apply Caneed Help
Agtion Mame Source  Destination Protestnl
F Allow  Allow to Fing WAN port WANT LANE2.163.01 Icmes 4
F Deny Default - [ 1P .
F Allw  Default [0 1P

computer you are running iChat from.

Leave the second box empty. Under Protocol, select UDP. In the port range boxes,
enter 5060 in the first box and leave the second box empty.
Click Always or set a schedule.

Step 4 Click Apply
and then Continue.

Step 5

Repeat steps 3 and 4
enterichat2 and
open ports 16384-

16403 (UDP).

D-Link

Building Metworks for Peopls

DI-624

Wirlual Server

Applicalions

Filters.

| EE

DMZ

Performance

[

—_Alr,pﬁ lus G-
High-Speed 2.4GHz Wireless Router

irewall Rules
Fliwall Rubes cam be used 10 allow of deny 1rafic from paseng thiough the DHE24

& Emabled T Digabied
Mams Iu:hu}ﬂ— Claetl
Action & Allew © Deny

imerface P Range Stan IF Range End  Protocel Fort Range
Source  [wan =] [ |
Destination [LAN_=] [152.168.0.100 | [uoF =] [1e3e . [iean:
Scheduls & Abways

day | Sun vI 10 |Sun =
2 90O
meall Rules List Apply Cancel Help
Aetion Name Source  Destination Protocol
F Allvw  Allow 1o Fing WAN pod WWAN"  LAN 18216801 (11 I §
F Deny Defaull A LAM 1P .
F Allew  Defaull LAaNT 7 1P m,”
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Frequently Asked Questions (continued)

How do | set up my router to use iChat? -for Macintosh users-
(continued)

For File Sharing:
Step 1 Click on
Advanced and then
Virtual Server.

~AirPlus =,
Xorenmels

High-Speed 2.4GHz Wireless Router

m Advanced W[ Status Help

Wirtual Server is used 1o allow Internet usess access to LAN sonices,

Step 2 Check Enabled
to activate entry.

Step 3 Enter a name for

& Enabled © Disablod

i Harne foes e
ypur virtual server entry A S [Gloar |
(ichat3). e e [__|[T,p

Filters Prvate Pant  [E190
Step 4 Next to Private Public Pt [F190

IP, enter the IP Address Firewall Sthedule & Avways
of the computer on your © From time [103] [00 5] [A4 = o [00 ] [0 2] [ 2]

{1

day|Sun =] 4o | Sun '-I
local network that you !
5 "
want to allow t_he S 9 00
incoming service to. Acply Cancel Help
Mame Private IP Protocol Schedule
I Vietusl Seever FTR o006 TER 2121 always IE) |
Step 5 Se'eCt TCP fOf 7 Vietusl Sesear HTTP 0000 TCP 8080 abways £y

Protocol Type.
Step 6 Enter 5190 next to Private Port and Public Port.
Stsp 7 Click Always or configure a schedule.

Step 8 Click Apply and then Continue.

If using Mac OS X Firewall, you may need to temporarily turn off the firewall in
the Sharing preference pane on both computers.

To use the Mac OS X Firewall, you must open the same ports as in the router:

Step 1 Choose Apple menu > System Preferences.

Step 2 Choose View > Sharing.

Step 3 Click the Firewall tab.

Step 4 Click New.

Step 5 Choose Other from the Port Name pop-up menu.

Step 6 In the Port Number, Range or Series field, type in: 5060, 16384-16403.
Step 7 In the Description field type in: iChat AV

Step 8 Click OK.
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Frequently Asked Questions (continued)

How do | send or receive a file via iChat when the Mac OSX firewall
is active? -for Macintosh users- Mac OS X 10.2 and later

The following information is from the online Macintosh AppleCare knowledge base:

“iIChat cannot send or receive a file when the Mac OS X firewall is active in its default
state. If you have opened the AIM port, you may be able to receive a file but not send
them.

In its default state, the Mac OS X firewall blocks file transfers using iChat or America
Online AIM software. If either the sender or receiver has turned on the Mac OS X firewall,
the transfer may be blocked.

The simplest workaround is to temporarily turn off the firewall in the Sharing preference
pane on both computers. This is required for the sender. However, the receiver may keep
the firewall on if the AIM port is open. To open the AIM port:

Step 1 Choose Apple menu > System Preferences.

Step 2 Choose View > Sharing.
Step 3 Click the Firewall tab.
Step 4 Click New.

Step 5 Choose AOL IM from the Port Name pop-up menu. The number 5190
should already be filled in for you.

Step 6 Click OK.

If you do not want to turn off the firewall at the sending computer, a different file sharing
service may be used instead of iChat. The types of file sharing available in Mac OS X are
outlined in technical document 106461, "Mac OS X: File Sharing" in the AppleCare Knowl-
edge base online.

Note: If you use a file sharing service when the firewall is turned on, be sure to click the

Firewall tab and select the service you have chosen in the "Allow" list. If you do not do
this, the firewall will also block the file sharing service. “
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Frequently Asked Questions (continued)

What is NAT?

NAT stands for Network Address Translator. Itis proposed and described in RFC-
1631 and is used for solving the IP Address depletion problem. Basically, each NAT
box has a table consisting of pairs of local IP Addresses and globally unique
addresses, by which the box can “translate” the local IP Addresses to global address
and vice versa. Simply put, it is a method of connecting multiple computers to the
Internet (or any other IP network) using one IP Address.

D-Link’s broadband routers (ie: DI-604) support NAT. With proper configuration,
multiple users can access the Internet using a single account via the NAT device.

For more information on RFC-1631: The IP Network Address Translator (NAT), visit
http://www.fags.org/rfcs/rfc1631.html
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Technical Support

You can find software updates and user documentation on the D-Link website.

D-Link provides free technical support for customers within the United States and
within Canada for the duration of the warranty period on this product.

U.S. and Canadian customers can contact D-Link technical support through our web
site, or by phone.

Tech Support for customers within the United States:

D-Link Technical Support over the Telephone:
(877) 453-5465
24 hours a day, seven days a week.

D-Link Technical Support over the Internet:
http://support.dlink.com
email:support@dlink.com

Tech Support for customers within Canada:

D-Link Technical Support over the Telephone:
(800) 361-5265
Monday to Friday 8:30am to 9:00pm EST

D-Link Technical Support over the Internet:
http://support.dlink.ca
email:support@dlink.ca

When contacting technical support, please provide the following information:
* Serial number of the unit
» Model number or product name

 Software type and version number
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Warranty and Registration
(USA only)

Subject to the terms and conditions set forth herein, D-Link Systems, Inc. (“D-Link”) provides this Limited
warranty for its product only to the person or entity that originally purchased the product from:

. D-Link or its authorized reseller or distributor and
. Products purchased and delivered within the fifty states of the United States, the District of

Columbia, U.S. Possessions or Protectorates, U.S. Military Installations, addresses with an
APO or FPO.

Limited Warranty: D-Link warrants that the hardware portion of the D-Link products described
below will be free from material defects in workmanship and materials from the date of original retail
purchase of the product, for the period set forth below applicable to the product type (“Warranty
Period”), except as otherwise stated herein.

3-Year Limited Warranty for the Product(s) is defined as follows:

. Hardware (excluding power supplies and fans) Three (3) Years
. Power Supplies and Fans One (1) Year
. Spare parts and spare kits Ninety (90) days

D-Link’s sole obligation shall be to repair or replace the defective Hardware during the Warranty Period
at no charge to the original owner or to refund at D-Link’s sole discretion. Such repair or replacement will
be rendered by D-Link at an Authorized D-Link Service Office. The replacement Hardware need not be
new or have an identical make, model or part. D-Link may in its sole discretion replace the defective
Hardware (or any part thereof) with any reconditioned product that D-Link reasonably determines is
substantially equivalent (or superior) in all material respects to the defective Hardware. Repaired or
replacement Hardware will be warranted for the remainder of the original Warranty Period from the date
of original retail purchase. If a material defect is incapable of correction, or if D-Link determines in its sole
discretion that it is not practical to repair or replace the defective Hardware, the price paid by the original
purchaser for the defective Hardware will be refunded by D-Link upon return to D-Link of the defective
Hardware. All Hardware (or part thereof) that is replaced by D-Link, or for which the purchase price is
refunded, shall become the property of D-Link upon replacement or refund.

Limited Software Warranty: D-Link warrants that the software portion of the product (“Software”)
will substantially conform to D-Link’s then current functional specifications for the Software, as set forth
in the applicable documentation, from the date of original retail purchase of the Software for a period of
ninety (90) days (“Warranty Period”), provided that the Software is properly installed on approved
hardware and operated as contemplated in its documentation. D-Link further warrants that, during the
Warranty Period, the magnetic media on which D-Link delivers the Software will be free of physical
defects. D-Link’s sole obligation shall be to replace the non-conforming Software (or defective media)
with software that substantially conforms to D-Link’s functional specifications for the Software or to
refund at D-Link’s sole discretion. Except as otherwise agreed by D-Link in writing, the replacement
Software is provided only to the original licensee, and is subject to the terms and conditions of the
license granted by D-Link for the Software. Software will be warranted for the remainder of the original
Warranty Period from the date or original retail purchase. If a material non-conformance is incapable of
correction, or if D-Link determines in its sole discretion that it is not practical to replace the non-
conforming Software, the price paid by the original licensee for the non-conforming Software will be
refunded by D-Link; provided that the non-conforming Software (and all copies thereof) is first returned
to D-Link. The license granted respecting any Software for which a refund is given automatically
terminates.

Non-Applicability of Warranty: The Limited Warranty provided hereunder for hardware and software
of D-Link’s products will not be applied to and does not cover any refurbished product and any product
purchased through the inventory clearance or liquidation sale or other sales in which D-Link, the sellers,
or the liquidators expressly disclaim their warranty obligation pertaining to the product and in that case,
the product is being sold “As-Is” without any warranty whatsoever including, without limitation, the
Limited Warranty as described herein, notwithstanding anything stated herein to the contrary.

Submitting A Claim: The customer shall return the product to the original purchase point based on its

return policy. In case the return policy period has expired and the product is within warranty, the
customer shall submit a claim to D-Link as outlined below:
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. The customer must submit with the product as part of the claim a written description of the
Hardware defect or Software nonconformance in sufficient detail to allow D-Link to confirm
the same.

. The original product owner must obtain a Return Material Authorization (“RMA”) number from
the Authorized D-Link Service Office and, if requested, provide written proof of purchase of
the product (such as a copy of the dated purchase invoice for the product) before the
warranty service is provided.

. After an RMA number is issued, the defective product must be packaged securely in the
original or other suitable shipping package to ensure that it will not be damaged in transit, and
the RMA number must be prominently marked on the outside of the package. Do notinclude any
manuals or accessories in the shipping package. D-Link will only replace the defective portion
of the Product and will not ship back any accessories.

. The customer is responsible for all in-bound shipping charges to D-Link. No Cash on Delivery
(“COD") is allowed. Products sent COD will either be rejected by D-Link or become the
property of D-Link. Products shall be fully insured by the customer. D-Link will not be held
responsible for any packages that are lost in transit to D-Link. The repaired or replaced
packages will be shipped to the customer via UPS Ground or any common carrier selected by
D-Link, with shipping charges prepaid. Expedited shipping is available if shipping charges are
prepaid by the customer and upon request.

Return Merchandise Ship-To Address
USA 53 Discovery Drive, Irvine, CA 92618
Canada: 2180 Winston Park Drive, Oakville, ON, L6H 5W1 (Visit http://www.dlink.ca for detailed
warranty information within Canada)

D-Link may reject or return any product that is not packaged and shipped in strict compliance with the
foregoing requirements, or for which an RMA number is not visible from the outside of the package. The
product owner agrees to pay D-Link’s reasonable handling and return shipping charges for any product
that is not packaged and shipped in accordance with the foregoing requirements, or that is determined
by D-Link not to be defective or non-conforming.

What Is Not Covered: This limited warranty provided by D-Link does not cover: Products, if in D-Link’s
judgment, have been subjected to abuse, accident, alteration, modification, tampering, negligence, misuse,
faulty installation, lack of reasonable care, repair or service in any way that is not contemplated in the
documentation for the product, or if the model or serial number has been altered, tampered with, defaced
or removed; Initial installation, installation and removal of the product for repair, and shipping costs;
Operational adjustments covered in the operating manual for the product, and normal maintenance;
Damage that occurs in shipment, due to act of God, failures due to power surge, and cosmetic damage;
Any hardware, software, firmware or other products or services provided by anyone other than D-
Link; Products that have been purchased from inventory clearance or liquidation sales or other sales in
which D-Link, the sellers, or the liquidators expressly disclaim their warranty obligation pertaining to the
product. Repair by anyone other than D-Link or an Authorized D-Link Service Office will void this
Warranty.

Disclaimer of Other Warranties: EXCEPT FOR THE LIMITED WARRANTY SPECIFIED HEREIN, THE
PRODUCT IS PROVIDED “AS-IS” WITHOUT ANY WARRANTY OF ANY KIND WHATSOEVER INCLUDING,
WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE
AND NON-INFRINGEMENT. IFANY IMPLIED WARRANTY CANNOT BE DISCLAIMED INANY TERRITORY
WHERE APRODUCT IS SOLD, THE DURATION OF SUCH IMPLIED WARRANTY SHALL BE LIMITED TO
NINETY (90) DAYS. EXCEPTAS EXPRESSLY COVERED UNDER THE LIMITED WARRANTY PROVIDED
HEREIN, THE ENTIRE RISKAS TO THE QUALITY, SELECTION AND PERFORMANCE OF THE PRODUCT IS
WITH THE PURCHASER OF THE PRODUCT.

Limitation of Liability: TO THE MAXIMUM EXTENT PERMITTED BY LAW, D-LINK IS NOT LIABLE
UNDER ANY CONTRACT, NEGLIGENCE, STRICT LIABILITY OR OTHER LEGAL OR EQUITABLE THEORY
FORANY LOSS OF USE OF THE PRODUCT, INCONVENIENCE OR DAMAGES OF ANY CHARACTER,
WHETHER DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL (INCLUDING, BUT NOT LIMITED TO,
DAMAGES FOR LOSS OF GOODWILL, LOSS OF REVENUE OR PROFIT, WORK STOPPAGE, COMPUTER
FAILURE OR MALFUNCTION, FAILURE OF OTHER EQUIPMENT OR COMPUTER PROGRAMS TO WHICH D-
LINK’'S PRODUCT IS CONNECTED WITH, LOSS OF INFORMATION OR DATA CONTAINED IN, STORED ON,
OR INTEGRATED WITHANY PRODUCT RETURNED TO D-LINK FOR WARRANTY SERVICE) RESULTING
FROM THE USE OF THE PRODUCT, RELATING TO WARRANTY SERVICE, OR ARISING OUT OF ANY
BREACH OF THIS LIMITED WARRANTY, EVEN IF D-LINK HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. THE SOLE REMEDY FOR ABREACH OF THE FOREGOING LIMITED WARRANTY IS
REPAIR, REPLACEMENT OR REFUND OF THE DEFECTIVE OR NON-CONFORMING PRODUCT. THE MAXIMUM
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LIABILITY OF D-LINK UNDER THIS WARRANTY IS LIMITED TO THE PURCHASE PRICE OF THE PRODUCT
COVERED BY THE WARRANTY. THE FOREGOING EXPRESS WRITTEN WARRANTIES AND REMEDIES
ARE EXCLUSIVEANDARE IN LIEU OF ANY OTHER WARRANTIES OR REMEDIES, EXPRESS, IMPLIED OR
STATUTORY.

Governing Law: This Limited Warranty shall be governed by the laws of the State of California. Some
states do not allow exclusion or limitation of incidental or consequential damages, or limitations on how
long an implied warranty lasts, so the foregoing limitations and exclusions may not apply. This limited
warranty provides specific legal rights and the product owner may also have other rights which vary
from state to state.

Trademarks: D-Link is a registered trademark of D-Link Systems, Inc. Other trademarks or registered
trademarks are the property of their respective manufacturers or owners.

Copyright Statement: No part of this publication or documentation accompanying this Product may
be reproduced in any form or by any means or used to make any derivative such as translation,
transformation, or adaptation without permission from D-Link Corporation/D-Link Systems, Inc., as
stipulated by the United States Copyright Act of 1976. Contents are subject to change without prior

notice. Copyright® 2002 by D-Link Corporation/D-Link Systems, Inc. All rights reserved.

CE Mark Warning: This is a Class B product. In a domestic environment, this product may cause radio
interference, in which case the user may be required to take adequate measures.

FCC Statement: This equipment has been tested and found to comply with the limits for a Class B

digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable

protection against harmful interference in a residential installation. This equipment generates, uses, and

can radiate radio frequency energy and, if not installed and used in accordance with the instructions,

may cause harmful interference to radio communication. However, there is no guarantee that interference

will not occur in a particular installation. If this equipment does cause harmful interference to radio or

television reception, which can be determined by turning the equipment off and on, the user is encouraged

to try to correct the interference by one or more of the following measures:

. Reorient or relocate the receiving antenna.

. Increase the separation between the equipment and receiver.

. Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

. Consult the dealer or an experienced radio/TV technician for help.

For detailed warranty outside the United States, please contact corresponding local
D-Link office.

FCC Caution:

The manufacturer is not responsible for any radio or TV interference caused by unauthorized
modifications to this equipment; such modifications could void the user’s authority to operate the
equipment.

(1) The devices are restricted to indoor operations within the 5.15 to 5.25GHz range. (2) For this
device to operate in the 5.15 to 5.25GHz range, the devices must use integral antennas.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must accept
any interference received, including interference that may cause undesired operation.

IMPORTANT NOTE:

FCC Radiation Exposure Statement:

This equipment complies with FCC radiation exposure limits set forth for an uncontrolled
environment. The antenna(s) used for this equipment must be installed to provide a separation
distance of at least eight inches (20 cm) from all persons.

s

This equipment must not be operated in conjunction with any other antenna.

[ Register your D-Link product online at http://support.dlink.com/register/ J
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Federal Communication Commission Interference Statement

This equipment has been tested and found to comply with the limits for
a Class B digital device, pursuant to Part 15 of the FCC Rules. These
limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates,
uses and can radiate radio frequency energy and, if not installed and
used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee
that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and
on, the user is encouraged to try to correct the interference by one of
the following measures:

- Reorient or relocate the receiving antenna.

- Increase the separation between the equipment and receiver.

- Connect the equipment into an outlet on a circuit different from that
to which the receiver is connected.

- Consult the dealer or an experienced radio/TV technician for help.

This device complies with Part 15 of the FCC Rules. Operation is
subject to the following two conditions: (1) This device may not cause
harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

FCC Caution: Any changes or modifications not expressly approved by
the party responsible for compliance could void the user's authority to
operate this equipment.

IMPORTANT NOTE:

FCC Radiation Exposure Statement:

This equipment complies with FCC radiation exposure limits set forth
for an uncontrolled environment. This equipment should be installed
and operated with minimum distance 20cm between the radiator & your
body.

This transmitter must not be co-located or operating in conjunction with
any other antenna or transmitter.



